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1. Application

The BENNING PC-Win ST 750 - 760 logging software en-
ables you to conveniently manage your databases.

You can create and export new databases or import exist-
ing databases and edit them using your PC.

The integrated Report Designer enables you to control
printing and to edit existing test reports subsequently.

The detailed “Getting started" dialog
makes it easier for you to familiarize yourself
with all the basic functions of the software. S

2. Safety instructions
2.1. Symbols used

A Attention! Please observe documentation!
&~ Note. To be observed imperatively.

> Instructions

® Registered trademark

2.2. General safety instructions

Please read the operating manual of the logging
software and the operating manual of the appli-
ance tester carefully and thoroughly before us-
ing the product. Please observe all instructions

A

3. Installation

3.1. General information

The BENNING PC-Win ST 750 - 760 logging software is
designed as a 32-bit program. If you are using a 64-bit op-
erating system on your PC, it will usually automatically rec-
ognize how the program works and install it in compatibility
mode. If your system does not run the installed software
correctly, you can start the compatibility mode manually.
To do this, follow the instructions of your operating system
according to the manufacturer's specifications. The neces-
sary steps to be taken depend on the installed operating
system and can be found on the Internet (keyword: com-
patibility mode).
3.2. System requirements
Operating system:
Windows® XP Home Edition, Service Pack 3 (or higher)

- Windows® Installer 3.1 (or higher)

- Internet Explorer 5.01 (or higher)

- .Net Framework 4.0 (or higher)
Recommended hardware performance:

- atleast Pentium® 1 GHz (or faster)

- atleast512 MB RAM
Minimum hard disk space:

- 2GB
3.3. Installing the application

You need administrator rights to install the log-

of the relevant operating manuals. C ging software.
The manufacturer generally recommends mak- The manufacturer recommends updating the
ing backup copies before making changes to (& printer drivers to avoid incorrect printing of test
A existing databases. This prevents unintentional reports.
loss of data in the event of an error. i - ;
Depending on the PC configuration and operat-
If you remove the appliance tester’s USB cable (&= ing system, installation might take several

or SD memory card from your PC, use the inte-
grated Windows® function " Safely remove
hardware and eject media" prior to removal.
This prevents unintentional loss of data in the
event of an error.

minutes.

Make sure to properly connect your appliance
tester or its SD memory card to your PC.

A bad connection might involve data loss during
a file transfer.

In case of proper use according to the specifica-
tions, the safety of your data is ensured.

The manufacturer assumes no liability for any
actions other than those described in this oper-
ating manual.

e

» Wait until the AutoStart function of the setup starts
with the installation.

» Insert the supplied CD-ROM into
your PC drive.

(If installation does not start automatically, manually
run the "setup.exe" file on the CD-ROM.)

» Confirm the installation and follow the instructions of
the setup wizard.

3.4. Starting the program for the first time

After successful installation, the logging software can be
started.

When you start the program for the first time, the detailed
“Getting started" dialog opens and guides you through
the basic functions of the software.
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4. PC-Win ST 750 - 760 user interface

EBENNING PC-Win 5T 730-760 - O Xoje— 1
File Edit User Wiew Help ? 2
8- 225 € AD & — 3
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5
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First steps
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— Either no database was found, or you want to change the

databaseinformation. Please choose one of the following options.

Create New Database
You start the software the first time (no e was fol
or you want to create s new database.

|
Choose Database
Choose this option if you want manually want to choose a
databs

i3

Register
Click here to register your software

In the future you can change this settings in the file menu of the main windows

. Ek [ MNet> | | Abbruch |

Area with operating elements 1
Title bar 2

Menu bar 3

Toolbar 4

Data explorer 5

Function field 6

“Getting started” dialog 7

Status bar 8
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4.1. Menu bar

File | Edit User View Help

Use the menu path Menu bar -> File to get to the options

described in the following.

You can manage databases, import data and learn how to
use the BENNING PC-Win software using the convenient

"Getting started" dialog.

e

=1 Database »

'-; Getting Started
Import Data
Exit

» |=L Create Mew Database
55 Select Database
. Save Database As
5 Merge Database
==, Repair Database
= Compress Database
= Close Database

Import Backup

. Getting started

Click this menu item to select an existing database or
create a new database. Optionally, you can register your
PC software online.

5 Import data

Click this menu item to import data from the
BENNING PC-Win 700 logging software and from
Microsoft® Excel.

(See chapter 9.4.)

Exit

Click this menu item to exit the BENNING PC-Win
software.

=L Create new database

Click this menu item to create a new database. This
database is empty and does not contain any entries at the
beginning.

(See chapter 5.1.)

5%  Select database
Click this menu item to select a database that you want to
work with in the software environment.
(See chapter 5.2.)

5. Save database as

Click this menu item to save the current database under a
new name. The current work database will not be
changed. You only create a backup of the current
database.

(See chapter 9.1.)

5 Merge database
Click this menu item to merge databases into a common
database.
(See chapter 9.5.)

+,  Repair database

Click this menu item to repair a corrupted database. You
will then receive feedback as to whether the repair was
successful.

(See chapter 9.6.)

= Compress database

Click this menu item to reduce the memory space
required by a database without data loss occurring.

(See chapter 9.7.)

= Close database

Click this menu item to close an open database. The
database is removed from the tree diagram and all open
file windows are closed.

Restore backup

The software creates various backups. Click this menu
item to restore a backup.

(See chapter 9.3.)



BENNING PC-Win ST 750-760

BENNING

File | Edit | User View Help

Use the menu path Menu bar -> Edit to get to the options
described in the following.

You can mark data in the file explorer with a mouse click
and copy them into the desired location using the options
"Copy" and "Paste".

Edit
Copy Ctrl+C
[ﬁ1 Paste Ctrl+V

Paste copy of test object

" The list is dynamic and may contain additional
functions if a tabular view is enabled.

Copy (Ctrl + C)

Copies the selected element (test sample or customer) to
the clipboard.

" Paste (Ctrl +V)

Adds an element (test sample or customer) from the
clipboard. Results will also be copied.

Paste copy of test sample

Creates an exact copy of a test sample without copying
stored results.

File  Edit | User | View Help

Use the menu path Menu bar -> User to get to the options
described in the following.

You can edit existing customer-specific tests and visual in-
spections and create, copy or delete new entries.

Uzer

Custom tests

Custormn view tests

Custom tests

Click this menu item to go to the "Custom tests" dialog
box.

(See chapter 6.1.)

Custom visual inspections

Click this menu item to go to the "Custom visual
inspections" dialog box.

(See chapter 6.2.)

File  Edit User | View | Help

Use the menu path Menu bar -> View to get to the options
described in the following.

By selecting "Customers", "Test samples" or “Test re-
sults", tabular overviews are provided in the function field.
In addition, you can statistically evaluate your selected da-
tabase, hide the data explorer and search for specific en-
tries in the tabular overviews.

View |
B Customers
= Test Samples
% Complete result list
W Statistic
Data Explorer
M Search Ctrl+F
Options
,_,“_‘ Customers

Displays an overview of all existing customers. You can
add, edit or delete customers and hide unnecessary
entries by using filters.

= Test samples

Displays an overview of all existing test samples. You can
add, edit or delete test samples and hide unnecessary
entries by using filters. In addition, you can also view the
test result of an individual test sample and mark overdue
test samples.

J  Testresults

Displays an overview of all existing tests. You can delete
unnecessary entries or hide them by using filters and view
the test result of an individual test.

i Statistics

Displays a statistical evaluation of all test samples.

Data explorer

Hides or shows the data explorer.

#  Search (Ctrl + F)

Displays the search function.

Options
Displays the options of the BENNING PC-Win software.
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File Edit User View

Help

Use the menu path Menu bar -> Help to get to the options

described in the following.

Help

Register your product
Check for Updates

Help
Benning 5T 755/ 5T 760 Help

FastReport Help

About

BENNIMG PC-Win 5T 750-760 Help

Information about other test devices

Register your product

You will be redirected to the Product and Software
Registration page on the BENNING website.

Check for updates

A dialog box opens showing update information for the

BENNING PC-Win logging software.

BENNING ST 755 - ST 760 help

Menu path to the description of the appliance tester

BENNING PC-Win ST 750 - 760 help

Menu path to the description of the logging software

FastReport help

Menu path to the Report Designer software

Information about other test devices

Link to the BENNING testers and measuring instruments

website

4.2. Toolbar

S-l25en

™ -

The toolbar serves as quick access to all frequently used
functions. A description of the functions can be found in

the chapter "Menu bar".

In addition to the functions from the chapter "Menu bar",
the functions of the menu item "Data explorer" are listed

here.

~ Database

Customers

P @

Test samples
Test results (tests)
Statistics

Search element
Copy

TS &L

Paste

Te~ Data explorer

m

[<]<]

Data shown

Refresh

Show data explorer

Expand to test results

— |(O ID

® MName

) IDand name F11

F9
F10

Show data explorer

Hides or shows the data explorer.

Expand to test results

If this option is enabled, the data explorer expands to

show the test results as well.

(=R Test_db_V61_20180129.db
BENNING (GER)
BENMING (NL)

.8 (Coffee machine |

R

t 12/25/2017 1:15:11
f 12/25/2017 59:32:03
f 12/25/2017 9:31:18
Electric: dril

t 12/29/2017 1:33:01
: f 12/25/2017 1:112:05

L 12/29/2017 1:08:54

enabled

=M Test_db_V61_20180129.db
BEMNING (GER)

o, BENNING (ML)

- Coffee machine |

P

- Flectric drl
% PRCD K 10mA
= PRCD-K 30mA
- Welding device
Test dept. |
Test dept. |l
BENNING (US)

EFIEE

disabled

Data shown (F9, F10, F11)

Changes the view in the data explorer according to the

selected option.

O D

Fo
|[§J Name F10 L\sJ

() IDand name F11

Refresh (F5)

Updates the display of the data explorer.
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4.3. Data explorer

The data explorer provides you with an overview of all da-
tabase levels.

4.3.1. Database levels

=N Test_db_VE1_20180129.db
- BENNING (GER)
== BENNING {NL)
=54/ Dept. Al
.= Coffee machine |
==, (Coffes machine
... PRCD-5+
- Welding device
M 12/29/2017 93
M 12/29/2017 93
Dept. A ll
- Flactic dril
.= PRCD K 10mA
=M 11242018 1:40

L 72017 11
[&-<% PRCD-K 30mA
BENNING (US)

To edit, create or delete a database level in the data ex-
plorer, select the corresponding level with a left mouse
click.

A right mouse click then shows you the options of the con-
text menu.

=l Database
Customer(s)
o Department(s)

=l Test sample(s)

Test result(s)

Expand or collapse database levels
Expands a single database level.

Collapses a single database level.
Expands all database levels.

Collapses all database levels.

=
El.
]

4.3.2. Data explorer functions

Context menu (right mouse click)

Depending on the database level selected, different func-
tions are available in the context menu.

Customer
3
gy Mew Customer
; Edit Customer
E?—' Delete Custormer
“n  Export customer data to separate database

Department

Rename department

Delete departernent

Test sample

'ﬂ Mew Test Sample
™ Edit Test Sample
'.E] Delete Test Sample

Test result
"= Show Result
|_5] Print Result
Delete Result
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4.4. Function field

=

& Customers - Test.db EI@
&2V

Customer Contactperson S
BENNING {US)

BEMMING {GER)

BEMMING {NL) v
< 3
MNo. of data records: 4/ 4
< Test Samples - Test.db E\@
222V B B

Customer Departement - 'IA
BEMMNI... |Dept. 105 HGM-OB 2
BENNI... |Dept. 105 #HGM-OB 2
BENNI... |Dept. 105 #HGM-OB 2 v
< >
No. of data records: 64 / 67

=) Test results - Test.db =N =R =
Y-8 E 2R

Customer 4 Designation Departemant
< >

Mo. of data records: 0/ 0

The selected menu items from the toolbar are displayed in

the function field.

Example:
Customers, Test samples or Test results

4.5, Status bar

EM\Test.db

The status bar shows the current directory of the selected

database.

Double-clicking on the status bar takes you to the folder

overview of the selected directory.

W) Pleass choose Database
« v N m s STTEO(E) v @ | SearchST760(E)
Organize v New folder
Name Date modified Type

# Quick access

[ Test.db 8/20/201811:22AM DB File

OneDiive
[ This PC
— STT60(E)

¥ Network
- <

File name: | Test.db ~| |ST755 Datei (*.db)

Open

4.6. “Getting started” dialog

»

——— /¥ )
Either no database was found. or you want to change the
databaseinformation. Please choose one of the following options.

Create New Database
You start the software the first time (no database was found]
or you want o creste 2 new database.

Choose Database
Choose this option if you want manually want to choose 3
databse

Register
Click here to register your software

In the future you can change this settings in the file menu of the main windows

Next > Abbruch

The "Getting started" dialog offers an easy introduction
into how to use the BENNING PC-Win logging software.
You can start with a new database or edit an existing
database. Navigate to the desired function and follow the
instructions displayed on your screen.

Since the "Getting started" dialog guides the user
conveniently through the basic functions of the software,
no detailed description of the steps to be taken is given in
this documentation.

A left mouse click on the menu item "Register" will take
you to the Product and Software Registration page on the
BENNING website.

After registration of your BENNING product, you will
benefit from a faster information service and our expert
24/7 service hotline.
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5. Getting started

5.1. Creating a new database

You can create a new database using different menu
paths.

If you are using the BENNING PC-Win logging software
for the first time, follow the instructions of the "Getting
started" dialog.

1. option (“Getting started” dialog)

-
Either no database was found. or you want to change the
databaseinformation. Please choose one of the following options.

Create New Database
You start the software the first time (no database was found)
or you want to create a new database.

Choose Database
Choose this option if you want manually want to choose 3
databse

Register
Click here to register your software

In the future you can change this settings in the file menu of the main windows

Next > Abbruch

Otherwise, navigate using the following menu paths:

2. option (menu bar)

|£] Database v |

Create Mew Database %J
Select Database

"7;? Getting Started

% Import Data Save Database Ac

Merge Database

Exit

Repair Database

M0 BF BB 6D (&

Compress Database

= Close Database

Import Backup

3. option (toolbar)

é -
|@, Create Mew Database X
5% Select Database

=

5. Save Database As
5 Merge Database

= Close Databasze

The "Save as" dialog box opens where you can select the
storage location for the new database to be created.

) save As X
<« v A > STTE0(E) v ®|  SearchST760 (E) »
Organize ¥ New folder =~ @
OneDiive A MName - Date modified Type Size
5 This pC [ Test.db #2018 11:22 AM DB File 106 KB
- STTE0(E)
i Network
o v < >
File name: | Test v
Save astype: |ST755 Datei (*.db) v
A Hide Folders Cancel

Select the storage location, enter a file name

(e. g. Test.db) and select the correct file type.

5T755 (*.dh) v

ST750 (*.sdf)

(&= ST 750 = *.sdf/ ST 755 - 760 = *.db

Confirm your selection and click the Save button.
An empty database is created and is available for further
editing.

The newly created database is automatically used for fur-
ther editing and displayed in the data explorer.

5.2. Select database
You can select an already existing database for editing.

If you are using the BENNING PC-Win logging software
for the first time, follow the instructions of the "Getting
started" dialog.

1. option (“Getting started” dialog)

-
Either no database was found. or you want to change the
databaseinformation. Please choose one of the following options.

" Create New Database
\ \ You start the software the first time (no datsbase was fou
or you want to create 2 new datsbase.

Choose Database
Choose thi if
databse

wiant manually want to €3

Register
Click here to reqister your software

In the future you can change this settings in the file menu of the main windows

Next > Abbruch
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Otherwise, navigate using the following menu paths:

2. option (menu bar)

i |

(]  Database 3
| |

Create Mew Database

57 Select Database

#

fu? Getting Started

v

Import Data Save Database A=

. Merge Database
Exit

Repair Database

B

Cormpress Database
Close Database

Import Backup

3. option (toolbar)

Il
14

Create Mew Database

sl | &

Select Database

N

Save Database As
5 Merge Database

Close Database

The “Select database” dialog box opens where you can
select the storage location for the database to be edited.

®| Select Database X
<« v A > STTEO(E) ~ @ | Search ST 760 (E )
Organize » New folder - M @
Name Dste modified Type Size
7 Quick access )
|| Test.db 8/20/2018 11:22 AM DB File 106 KB
OneDrive
[ This PC
- ST 760 (E)
¥ Network
« >
File name: | Test.db ~| (57735 Datei by ~
==

Select the corresponding storage location, select the da-
tabase to be edited and click the Open button.

The selected database opens and is available for further
editing.

Please observe the correct database format
when opening a database.

It is possible to select older databases of the
ST 750 and ST 750 A appliance testers.

These have a different database format (*.sdf)
than the ST 755/ST 760 appliance testers
(*.db) and are hidden in the “Select database"
dialog box in case of wrong selection!

In the “Select database" dialog box, the filter for the corre-
sponding database formats can be changed.

577535 Datei (*.db) ~

5T 750 Datei (*.5df)

After successful selection, the selected database is dis-
played in the data explorer.

To make sure that you can use this database to its full ex-
tent on your appliance tester, at least 1 customer must be
created.

5.3. Creating a new customer

After you have selected a database for editing, you can
now add a desired number of customers to it.

1. option (data explorer context menu)

T m MNew Customer 5 |

Edit Customer b

Delete Customer

Export customer data to separate database

'ﬂ Mew Test Sample
M Edit Test Sample
% Delete Test Sample

Show Result
i Print Result
Delete Result

@ Statistic

Rename Building
Delete Building
Rename department
Delete departement

Expand All
Collapse All

- B

Search Element Ctrl+F

Refresh F3

Copy
Paste

= Close database
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2. option (menu bar)
View
|rﬁ:| Custormers E
= Test Samples
% Complete result list
& Statistic
Data Explorer
M Search Ctrl+F
Options

The "Customers" function opens in the function field.
There, you can edit customer entries using the following
buttons:

3.

~
L]

e Y-8

option (toolbar)
d-1829 ¢ o
The "Customers" function opens in the function field.

There, you can create new customer entries using the fol-
lowing buttons:

S V- | B

M -

~
L]

After you have selected the New customer func-
tion using one of the three options, the "Customer”
dialog box opens.

Customer x
G Please enter customer data
e S Customer: || |0
L u j Mame... | |
Department: | |
Caontact:
Phone no. 1: | |
Phone no. 2: | |
Faxno.: | |
E-Mail 1: | |
E-Mail 2: | |
Address
Street: | |
Postal code: | |
Place: | |
MNotes
Cancel

10

Enter the required customer data in the corresponding
lines of the "Customer” dialog box and confirm your entries
by clicking "OK”.

After having successfully entered the data, you will see the
customer entry in the data explorer under the selected da-
tabase.

- Testdb

s c.stomer

You can also view the customer entry in the function field.
To do this, the tabular “Customers” view must be enabled
(options 2 and 3).

~ ) b
r"J - \I"
Customer Contactpersan Street

City

To make sure that you can use this database to its full ex-
tent on your appliance tester, at least 1 test sample must
be created.

Test Street 12

5.4. Creating a new test sample

After you have created a new customer, you can now add
a desired number of test samples to it.

1. option (data explorer context menu)

B[ Testdb3 |

Mew Customer

Edit Customer
Delete Customer

Export customer data to separate database

N & e o ke

Mew Test Sample I

Edit Test Sample
Delete Test Sample
Show Result

Print Result

Delete Result

Statistic

Rename Building
Delete Building
Rename department
Delete departement

Expand All
Collapse All

Search Element Ctrl+F

S i, f

Refresh

Copy
Paste

F3

Close database
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2. option (menu bar)

View

B Customers
|‘?_| Test Samples |, |
'@ Complete result list

W Statistic

« | Data Explorer

M Search Ctrl+F
Options

The “Test samples” function opens in the function field.
There, you can edit or influence test sample entries using
the following buttons:

A2 V-0 =0

3. option (toolbar)

:EJ:T (a_l IE"j l‘l' 'n' [ﬁ1 T—ET
The “Test samples” function opens in the function field.

There, you can edit or influence test sample entries using
the following buttons:

A38 V-8 2O

After you have selected the New test sample
4= function using one of the three options, the “Test
sample” dialog box opens.

Test Sample x
"{ Please edit the test sample data.
I‘. - Designation: ‘ ~ |0
Serial no.: ‘ |
Manufacturer: ‘ ~ |

Mominal power (K\W) 000t
Line length (m) 50k

Cross-sectional area (mm?) 1501

No. of conductors: 3
Output voltage (V): 0.0/
Customer: Test customer S
0 | )
Department: ‘Depl. Al - |
Out of Order: O

Test Options
Test.. v
View test: Default ~
Test interval: annually v | |5
Test date: ‘ [k | @
Next test: [ 8r20/2018 B |

Note

Cancel

11

Enter the required test sample data in the corresponding
lines of the "Test sample” dialog box and confirm your en-
tries by clicking "OK”.

Mandatory fields: Designation, ID + Test (test procedure)

When entering your test sample data, pay par-
(&~ ticular attention to the " Department™ input
field.

The "Department" input field generates an additional data-
base level and allows you to structure your test samples
more precisely.

Thus, within the corresponding company, a better
overview of the local distribution of your test samples is
provided.

As an example, the following database shows several test
samples with and without a department being assigned.

SR Test_db_VE1_201380123.db

m-., BENNING (GER)

=~ BENNING (NL)

[ - =% Coffee machine | |
=k Dept. A

[ Coffee machine 1]
----- = PRCD-5+

- Welding device
(-4 Dept. Al

-, BENNING (US)

Test sample without a department being assigned:

I‘;l Caoffee machine | |

Test sample with a department being assigned:

E-54/ Dept. Al
i [ Coffee machine Il
The department level is not required to use the
(&= database to its full extent on your appliance
tester.
If the department level is not used for a large
(&= number of test samples, this might involve

longer loading times at the appliance tester.
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After having successfully entered the test sample data,
you will see the test sample entry in the data explorer un-
der the selected database.

1| Test.db
- Test customer
Elzj: T_est Dept.
] PCRO-5

You can also view the test sample entry in the function
field.

To do this, the tabular “Test samples” overview must be
enabled (options 2 and 3).

A22 V1820
Customer Department Test

Now that your database contains the required customer,
department and test sample entries, you can export them
to your appliance tester.

12

6. Customer-specific tests and visual in-
spections

You can create your own test procedures using customer-
specific tests and visual inspections.

Use the following menu path to go to the customer-specific
tests/visual inspections where you can edit them, create
new entries and copy and delete existing ones.

User

Custom tests

Custom wview tests

6.1. Customer-specific tests

&=

To use the Custom tests function, a database
must be selected.

Create a new database or select an already existing data-
base.

In this example, the database New.db has been created
and selected.

=" MNew customer
EIfJ*_x I‘\lew department
-l New test sample

Use the following menu path to navigate to the Custom
tests function.

User

| Custom tests

I,
Custom view tvas,ts,l"‘f

The following dialog box opens:

85 Test definitions.

| ©| |0 |#& [ Show default tests

Name Grenzwerte SK
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) Create customer-specific test

This function creates a new customer-specific test
procedure.

13 Copy customer-specific test

This function copies existing customer-specific tests or
standard test procedures.

X Delete customer-specific test

This function deletes an existing customer-specific
test.

Thresholds Customer-specific limits

You can use this function to create test-related limits for
customer-specific tests.

Limits can only be created or modified if at least one
individual test is enabled (e. g: RPE, Rinsu, IPE...).

These specified limits apply to the selected customer-specific
test procedure and do not apply to standard test procedures.

Changed limits are highlighted in color and can be reset to
the factory settings using the Reset button.

Color marking of changed limits:
(e. g.: RPE limit in [Q])

Standard limit (font color: black)

RPE (C)[0.3 |

Below standard limit (font color: yellow)

RPE (1) | |

Standard limit exceeded (font color: red)

RPE (1)

na4
U=

Delete thresholds Delete limits

This function deletes all individual limits of the selected
customer-specific test and resets the limits to the
factory settings.

Show default tests

This function displays the pre-installed standard test
procedures.

You can select a standard test procedure, then copy it and
create it as a customer-specific test procedure with a
different name and changed configuration.

6.1.1. Creating a customer-specific test

) Navigate to the Create customer-specific test
button.

Assign a name for the customer-specific test procedure
and select the required DIN standard and protection class.

Enable at least one of the individual tests

(e. g.: RPE; RInsu, IPE ...).

Optionally, you can assign individual limits for
the customer-specific test.

To do this, click the Limits button and confirm
the confirmation prompt with "Yes".

Edit the corresponding limits.

If no changes are made to the limits, the pre-
installed default values apply.

Confirm your entries by clicking the Save button.

The test procedure can be used after the data have been
saved.
6.1.2. Copying a customer-specific test

Select a standard or customer-specific test procedure.

o Test definitions

& L_|_| x [] Show default tests
Name Thresholds SK

- e

(Check “Show default tests" to get an overview of the
standard test procedures.)

= Navigate to the Copy customer-specific test
button.

A copy of the selected test procedure will be created. The
name of the selected test procedure is preceded by "Copy
of ...".

o Test definitions

& x [] Show default tests

Mame Thresholds
J- MNew Test X

CopiontonTea| |

You can configure the copied entry and save it under a
different name.
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6.1.3. Deleting a customer-specific test

Select a customer-specific test procedure.

B Test definitions

|g| [] Show default tests

SK

Mame Thresholds

Navigate to the Delete customer-specific test
button.

X

Confirm the confirmation prompt with "Yes".

The customer-specific test procedure is irrevocably de-
leted.

6.2. Customer-specific visual inspections

To use the Custom visual inspections func-
tion, a database must be selected.

&

Create a new database or select an already existing data-
base.

Use the following menu path to navigate to the Custom
visual inspections function.

User

Custom tests
Custom view tests b

The following dialog box opens:

ﬂ Custom view tests
R EBR

Visual test

14

ﬁ Create customer-specific visual inspection

This function creates a new test question for customer-
specific visual inspections.

®

You can use this function to edit an existing customer-
specific test question.

This function deletes an existing customer-specific test
question.

Edit customer-specific visual inspection

Delete customer-specific visual inspection

6.2.1. Creating a customer-specific test question

Q Navigate to the Create customer-specific

visual inspection button.
Enter the required test question in the text input field "Vis-
ual inspection”.

Visual test

Please edit the visual test

ls the gas check valve closed?|

Confirm your entries by clicking “OK”.
The test question can now be used in the selected data-
base.

6.2.2. Editing a customer-specific test question

Select the test question to be edited in the Custom visual
inspections dialog box.

85 Custom view tests
IRER

Visual test
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Click the Edit customer-specific visual
inspection button.

Visual test

Please edit the visual test

Is the gas check valve closed?|

Modify the test question to be edited and confirm your en-
tries by clicking “OK”.

6.2.3. Deleting a customer-specific test question

Select the test question to be deleted in the Custom visual
inspections dialog box.

a5 Custorn view tests

R AR

Visual test

Click the Delete customer-specific visual
inspection button and confirm the confirmation
prompt with "Yes".

The test question is deleted.

15

7. Tabular views

Wiew
ﬁ, Customers

= Test Samples
g Complete result list

The tabular views provide an overview of all entries of the
corresponding database level.

~

£a Customers

The tabular Customers view provides an overview of all
existing customers of the selected database.

You can add, edit or delete customers and hide
unnecessary entries by using filter functions.

=

The tabular Test samples view provides an overview of all
existing test samples of the selected database.

Test samples

You can add, edit or delete test samples and hide
unnecessary entries by using filter functions.

“)

The tabular Test results view provides an overview of all
existing test results of the selected database.

Test results

You can delete unnecessary entries or hide them by
using filters.
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Tabular views are called in the function field of the
BENNING PC-Win logging software.

=

,;Z Customers - Test.db E\@
l‘?ﬁ rﬂa SQJ Y' @ |
Customer Contactperson S

BENNING (US)

BENNING (GER)

BENNING (NL) 4

£ >

Mo. of data records: 4/ 4

<2, Test Samples - Test.db E\@

A3a8 V-8 2O

Customer Departement FON ~
BENNI... |Dept. 105 #GM-OB 2
BENNI... |Dept. 105 #5M-0B 2
BENNI... |Dept. 105 #GM-OB 2 v
< >

No. of data records: 64 / 67

Test results - Test.db

LAY

Customer 4 Designation Departement

< >

No. of data records: 0/ 0

Use the following buttons to minimize, maximize or close
a tabular view.

If you maximize a tabular view, that view expands to the
size of the function field. Thus, views that are already open
might be covered.

The covered views are still open in the background and
can be uncovered as follows:

Navigate to the view again via the menu path View ->
Customers / Test samples / Test results

View

®  Customers

Fa

= Test Samples

g Complete result list

or click the following buttons on the right of the menu bar.

- 8] x

7.1. Filtering data

' Apply filter
In the tabular views, you can filter certain database
entries applying a logical filter function.

In the following, the basic functionality of the filter is ex-
plained using some examples.

Date of test

before v | [7/ 1207 @+

All test results before 15t July 2017 are displayed.

Date of test

|before | [7 172017 @]

Customer

and -

|Cu§omernameis V| |BENNING v|

See the logical operation of these filter settings below.

Date of test

(vor 7/ 1/ 2017)
AND

A 4

RESULT

Customer

(Customer is: BENNING)

Result:

Only entries that fulfill both filter characteristics (date of
test + customer) are displayed.

So, only entries that were tested before 15t July 2017
and belong to the customer BENNING are displayed.

Date of test

before v| |7 12017 @ |

Customer

ar e

|Cu§omer name is V| |EENNING v|

See the logical operation of these filter settings below.

16
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Date of test

(vor7/1/2017)

OR RESULT

4

Customer
(Customer is: BENNING)

Result:

Only entries that fulfill one of the two filter characteristics
(date of test + customer) are displayed.

So, all entries that were tested before 1t July 2017
are displayed.

+
All entries belonging to the customer BENNING are
displayed.

Filter selection:
e. g. date of test AND customer OR department

Date of test
~| | 71207 @

before

Customer

and

Customer name is v EENNING ~
Department

or ~

Department is ~ |New departmant v|

See the logical operation of these filter settings below.

Date of test

(vor 7/ 1/2017)
AND
Customer

(Customer is: BENNING) |

Department
(Department is: New department)

OR RESULT

Result:

All entries that fulfil both filter characteristics (date of test
+ customer) of the AND operation or correspond to the fil-
ter characteristic (department) of the OR operation are dis-
played.

So, all entries that were tested before 15t July 2017 and
belong to the customer BENNING are displayed.

+
All entries belonging to the department New depart-
ment are displayed.

You can use this function to delete your current filter
settings.

Delete filter

17

7.2. Selecting columns to be displayed

In a tabular view, you can manually select the number of
visible columns.

To do this, navigate to the Select columns function.

You can go to the Select columns function by right-clicking
in the table pane of the tabular view.

- oM
L TR E] f" @
Customer Contactperson

New custome Export Table »

| Choose columns l} |

Example: Tabular “Customers” view

The following dialog box opens:

Choose columns to show

Customer
Contact person
Street

Place

[] Department
[] Phone no. 1
[] Phone ne. 2

[] Fax ne.

[] Email 1
[] Email 2

[] Pestal code
[] Motes

Ok Cancel

Example: Tabular “Customers” view

Select the required columns and confirm your selection by
clicking “OK”.

You will get back to the tabular “Customers” view.

~ ~ [
L] rn- =] f' @
Customer Contactperson Street City

Example: Tabular “Customers” view

The columns are displayed according to your selection.
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7.3. Sorting entries
7.3.1. Alphabetical or numerical sorting

You can sort entries by a particular characteristic in as-
cending and descending order independently of filter set-
tings.

The data are sorted alphabetically or numerically in as-
cending or descending order according to the selected col-
umn.

Use a left mouse click to select the header of a column the
entries of which you want to sort.

Customer Customer
BENNING (GER) [l | BENNING (US) 7|
BENNING (ML) Z BENNING {NL) A

BEMMING (L5) BENNING (GER})

Example: Alphabetical sorting of the Department column

In columns with numerical designations, the data are
sorted in ascending and descending numerical order.

7.3.2. Changing the order of columns

If you have enabled several columns in a tabular view, you
can change the order of the columns by moving them.

A3a V-0 =2E

Customer Device Manufactursr
—-
BEMMNING (LIS} Kopp

BEMNING (US)
BEMMING (US)

1.0001
1.0001.0

Fronius

Fronius

Example: Tabular “Test samples” view

Navigate to the header of the corresponding column (e. g.
ID) and hold down the left mouse button.

Now, move the corresponding column (ID) in horizontal di-
rection until it has reached the desired position.

=

238 V-1

Customer

BENNING {US)

BENNING (US) Kopp 00007
BENNING (US) Fronius 1.0001
BENNING (US) Fronius 1.0001.0

Release the left mouse button. After having released the
mouse button, the column remains at the corresponding
position.

7.4. Creating / editing / deleting entries

Depending on the tabular view selected, you can create,
edit or delete entries using different buttons.

7.4.1. Creating entries

Tabular “Customers” view
A new customer is created.

~
o
-E' Tabular “Test samples” view

- Tabular “Test results” view

A new test sample is created.

(A test can only be created by real testing using
the appliance tester.)

Follow the prompts of the corresponding dialog box after
you have clicked one of the buttons.

Input fields marked with the following symbol are manda-
tory fields that must be filled in when creating a customer
or test sample.

0 Mandatory fields

9

Diesignation: || e

Example: Mandatory field for creating a new test sample

7.4.2. Editing entries
_;'_ﬂ Tabular “Customers” view
% Tabular “Test samples” view

“‘f Tabular “Test results” view

Follow the prompts of the corresponding dialog box after
you have clicked one of the buttons.
Editing multiple entries simultaneously

To do this, select multiple entries simultaneously in the
tabular view and click the corresponding Edit button.

222|710 =2E
Customer ] Device M

BENNING (US) 1,0001.0001

Example: Tabular “Test samples” view
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Confirm the confirmation prompt with "Yes".

Pleaze confirm.

e Are you sure that you want to edit 4 test samples

Yes

When editing multiple test samples, all input fields that do
not have a common designation are grayed out in the fol-
lowing dialog box.

Example:

222 v 0=0

Test

—

1]

Customer Departmant Manufac.

BENNING | Test Dept,
BENNING | Test Dept,
BENNING | Test Dept,

Tabular test sample overview — ID column deviates

1001274

The designations of the selected test samples are different
in the ID column.

The designation of the customer is identical with regard to
the following aspects:

Customer,
Department,
Test and

Manufacturer.

This is why the ID input field can not be edited in the dialog
box for modifying multiple test samples.

10

All common designations can be edited.

7.4.3. Deleting entries

&
[

2
®

Follow the prompts of the corresponding dialog box after
you have clicked one of the buttons.

Tabular “Customers” view
Tabular “Test samples” view

Tabular “Test results” view

The corresponding entry will be deleted irrevocably!

19

7.5. Exporting tables

Navigate to the desired tabular view and right-click one of
the listed entries.

Then, continue navigating via Export table.

V-1 |5 E®

Customer Designation Departement

BEN Print selected protocols
REM Print senial log for selected test samples
< PDF Export v
No. o
3 Show results
Export Table M b
by
Choose column
Please click: Export as Excel-XML file

Select the storage directory and the desired file name. The
BENNING PC-Win logging software exports the complete
tabular view to the desired directory.

You can then open the .xml file via Microsoft®-Excel® or
a suitable XML program from the storage directory.

7.6. Special functions of tabular views

Some functions are only available for the corresponding
tabular view.

7.6.1. Tabular “Test samples” view

Printing the latest test report for selected test samples
Navigate to the tabular Test samples view.

Select one or more test sample entries and right-click to
navigate to the context menu.

Select the “Print latest test report for selected test sam-
ples” function.

232|718 =0
Kunde ID
BENNING {US) 00003
Print |atest test record for selected test samples
Print serial log for selected test samples

PDF Export

]

-

»
T Show results
Export Table

Choose column

Follow the prompts of the corresponding dialog box and
confirm printing by clicking the “Print” button.

The BENNING PC-Win logging software prints the lat-
est (most recent) test report for the selected test sample
entries.
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7.6.2. Tabular “Test results” view 8. Statistics

Displaying visual inspections and measuring results

Navigate to the tabular Test results view. The "Statistics" function allows a statistical evaluation of

the following database levels:

pma  Select a test sample entry and click the button

i ; ' i=l~ Database -> Database statistics
next to it to display the corresponding test result.

~ i
The dialog box of the selected test opens. es  Customer -> Customer statistics
You can use"the buttons “Visual inspections” and “Meas- Department -> Department statistics
uring results" to display the evaluations of the individual
inspections as well as all the questions contained in the a |-> Contains also a statistical distribution of
visual inspection. the error causes.

(7 Visual tests () Measuring Results ] o
8.1. Calling statistics

Printing selected reports

. . There are different menu paths to call the required statis-
Navigate to the tabular Test results view. P q

tics.
Select one or more entries and right-click to navigate to

the context menu. 1. option
(Navigate from the top database level to the sub-

Select the "Print selected reports” function in the context ordinate statistics using the interactive pie

menu. charts.)
\"T I-l L | Ems X . .
28 | |l To do this, select the top database level "Database" in the
data explorer.
Customer Designation Departement

In this example, the following database is used:

- Test db_ V61 20180129.db.
Print selected protocols
Print serial log for selected test samples =R Test_db_V&1_2018012%.ch
#-" BENMING (GER) h‘

PDF Export k T O .
BEMMING (ML)
[T  Show results - BENMING (US)
Export Table 3

By selecting the "Database", a corresponding "Database
statistics" will be generated in the next step.

Choose column

1. Selecta hardware printer as printer (not a PDF For this, navigate to the "Statistics" function via one of the
printer). following menu paths.

2. Start the print job.
View

The BENNING PC—Win. logging software senc_is all se- & Customers
lected test sample entries to the hardware printer one =
after the other. ®  Test Samples

'ﬂ Complete result list

|« Statistic ; |

Data Explorer

M Search Ctrl+F
Options
Menu bar
= .:u, i@!‘! 5 B
Toolbar

20
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You will get to the "Database statistics“ dialog box.

o5 Databasestatistic x
B &
Datzbase: Test_db_VE1_20180129
g )
Distribution of test objects to the customer
BN BENNING {US) (19.09 %) B BENNING (ML) (6.36 %)
BENNING (GER) (74.55 %)
4 o ) h
Diistribution of test result to total number of test objects
B Not tested (20.00 %) Passed (69.09 %) B Test failed (10.91 %)
. S
MNumber of test objects: 110 Overdue test objects: 40 (36.36%)
Tested test objects: B8 (80.00%)
Mot tested test objects: 22 (20.00%)
Relationship passed / failed test objects to total number of test objects
Passed tests: 76 (86.36%) Failed tests 12 (13.64%)
< >

To create “Customer statistics" or “Department statistics",
you can now navigate to the subordinate statistics using
the interactive pie charts.

To do this, move the mouse pointer over the required sec-
tion of the interactive pie chart.

The selected section of the interactive pie chart is visibly
split off and can be clicked with the mouse.

e 2
Distribution of test objects to the customer
I BENNING (US) (19.09 %) B BENNING (NL) (6.36 %)
BENNING (GER) (74.55 %)
S J

Customer: BENNING (NL)

21

After successful execution, the corresponding statistics
opens.

In this example, the “Customer statistics” of BEN-
NING (NL) opens and provides an overview with regard to
the following:

- Distribution of test samples to the departments
Total number of test samples

Overdue test samples

Tested test samples

Not tested test samples

Passed tests

Failed tests

The interactive pie chart of the “Customer statistics" for

BENNING (NL) concerning the department can be used in
the same way.

82! Customer statistic s
B &
Customer: BENNING (NL) Mo. of departements: 3
' )
Distribution of test ohjects to departements
Departments
I Dept. A Il (42.86 %) Dept. Al (42.86%) M Unknown (14.29 %)

A v
' )
Distribution of test result to total number of test objects

N Mot tested (14.29 %) Passed (57.14 %) B Test failed (28.57 %)
. S
Total number of test objects 7 Owverdue test objects: 4 (57.14%)
Tested test objects: 6(85.71%) Test objects not tested: 1 (14.29%)
Relationship passed / failed test objects to total number of test objects
Passzed test objects: 4 (66.67%) Failed test objects: 2 (33.33%)

You can move the mouse pointer over a section of the in-
teractive pie chart and click this section.

Thus, you will get to the "Department statistics” of the se-
lected department.

In this example, the test department “Dept. A I” of the “Cus-
tomer statistics" for BENNING (NL) is used.
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Moreover, the "Department statistics" contains an over-
view of the distribution of error causes with regard to the

corresponding test samples.
) Departement statistic »
B &
Departement: Dept Al
4 ™

Distribution of test result to total number of test objects

W Not tested (33.33 %) Passed (33.33 %) W Test failed (33.33 %)

o y
MNumber of test objects 3 Overdue test objects 2 (66.67%)
Tested testobjects 2 (B6.67%)
Test objects not tested 1 (33.33%)
Relationship passed / failed test objects to total number of test chjects
Passed tests: 1 (50.00%) Failed tests: 1(50.00%)
g )
\; P Distribution of error reasons
Error causes
Error visual inspection (100.00 Error electrical test (0.00
%) bt
Error functional test {(0.00
o y

In this example, the “Department statistics”" of the
Dept. A | provides an overview with regard to the follow-

ing:
Total number of test samples
Overdue test samples
Tested test samples

Not tested test samples
Passed tests

Failed tests

Information on errors during visual inspection
Information on errors during functional testing

Information on errors during electrical testing
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2. option
(Select the database level of the required statis-

tics directly.)

Database -> Database statistics

=

~

A Customer -> Customer statistics

Department -> Department statistics

In the data explorer, navigate directly to the database level
of the required statistics.

= 4 Test_db_V61_20180129.db3
&~ BENNING (GER)

= BENNING (NL)

;'- Coffee machine |

&8

{ =™ Coffee machine ||

.= PRCD-5+

: G- Welding device

[-44 Dept. All

&~ BENNING (US)

In this example, the department Dept. A | of the customer
BENNING (NL) is used.

Use the following menu path to navigate to the "Statistics"
function.

View

5 Customers

= Test Samples

% Complete result list

& Statistic "

Data Explorer b
M Search Ctrl+F
Options

You will get directly to the corresponding statistics.

In this example, the “Department statistics" of the test de-
partment “Dept. A I” of the customer BENNING (NL)
opens.
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8.2. Printing statistics

Each dialog box of the statistics contains the following but-

tons.

! Departement statistic

[ &

(e. g.: department statistics)

Navigate to one of these buttons to start the print job of the

required statistics.

5|

Print preview

A print preview is generated. All print functions can be

operated from there.

B Preview

Sopnt B Esave - 210 4 [ gof1 p b cose

Page Lof L

EFEEEECRY

gz Print

The "Print" dialog box opens.

You can edit the printer settings and start the print job

for the selected statistics.

Print

Printer

= Adobe POF ~ Settings...
[] Print ta file

Page range Copies
@ Al Count: 1 >
(0) Current page
GE - — 2 ol

Enter page numbers andfor pageranges,

separated by commas. For example, 1,3,5-12

Mare options Cancel
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9. Database options
9.1. Saving a database

=

Save database as

You can save a database created or edited on the PC

to your appliance tester using the "Save database as"
function.

\ 4

The target directory for all databases is the
SD memory card of your appliance tester.

Save the database directly to the SD card!
The database must not be located in a sub-

& folder, since subfolders are ignored by the ap-

pliance tester when searching for database for-
mats.

SD card access:

1.

option
(Connect the appliance tester to the PC via a
USB cable.)

After having connected the appliance tester, the PC rec-
ognizes the appliance tester as a removable medium and
enables access to the inserted SD card.

Please make sure that the appliance tester is in operating

mode.

2.

option
(Connect the SD card via an SD card reader.)

(An SD card reader is not included in the scope of deliv-

ery.)
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After having connected the SD card reader, the PC recog-
nizes the inserted SD card as a removable medium.

After the PC has recognized the SD card as a removable
medium, use the "Save database as" function to open the
"Save as" dialog box and select the SD card as the storage
location for the database.

L *
« “ 1 = » USBDrive () ~ | @ | Search USB Drive (F: »
Organize *  MNew folder = @
Name Date modified Type
3t Quick access
Backups 4/18/2017 10:23 AM  File folder
OneDrive
[ This PC
— USB Drive (F:)
Backups
¥ Metwork
< >
File name: | New.db -
Save as type: | 5T755 Datei (*.db) ~
A~ Hide Folders Cancel

Select the SD card as storage location and assign a data-
base name as well as the corresponding database format.

5T735 (*.dh)

5T 750 (*.sdf)

Then, confirm saving by clicking the Save button.

If you remove the appliance tester’'s USB cable
or SD memory card from your PC, use the inte-
grated Windows® function " Safely remove
hardware and eject media" prior to removal.
This prevents unintentional loss of data in the
event of an error.

A
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9.2. Reading a database from the appliance
tester

Databases created by means of an appliance tester can
be copied from the SD memory card of the appliance tester
to a PC.

\ 4

SD card access:

The database directory of the appliance
tester is located on its SD memory card.

1.

option
(Connect the appliance tester to the PC via a
USB cable.)

After having connected the appliance tester, the PC rec-
ognizes the appliance tester as a removable medium and
enables access to the inserted SD card.

Please make sure that the appliance tester is in operating

mode.
2. option

(Connect the SD card via an SD card reader.)

(An SD card reader is not included in the scope of deliv-
ery.)

After having connected the SD card reader, the PC recog-
nizes the inserted SD card as a removable medium.

Open the directory of the removable medium via the Ex-
plorer of your Windows® PC after it has recognized the SD
card as a removable medium.
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After successful execution, the existing databases of the
appliance tester as well as a file folder "Backups” are dis-
played.

For more information on the "Backups" folder, refer to the
notes in chapter 9.3.

s USE Drive (F)

o x
L]

E select an

Select none

v]

Properties

5 invert setection
Select

@
Clipboard

P N

Open

USB Drive (F:) ] Search USE Drive (F:

Mame Type

# Quick access
Backups M File folder

2] 1.db M Data Base File
%] Test.db n V Data BaseFile
%] Test_db_V61_20180129.db 8/10/2018 11:55 PM  Data Base File

OneDrive

[ This PC

¥ USE Drive ()
Backups

& Network

ditems

Select the required database(s) (recognizable by the file
extensions .db/.sdf) and copy them to a local directory on
your PC.

You can now edit the local copies of your database using
the BENNING PC-Win logging software.

The manufacturer generally recommends mak-
ing backup copies before making changes to
existing databases. This prevents unintentional
loss of data in the event of an error.

A

If you remove the appliance tester’'s USB cable
or SD memory card from your PC, use the inte-
grated Windows® function " Safely remove
hardware and eject media" prior to removal.
This prevents unintentional loss of data in the
event of an error.

25

9.3. Database backups

Database backups are created automatically and in differ-
ent ways.

The appliance tester has a pre-installed configuration and
creates a maximum of 5 database backups.

The BENNING PC-Win logging software can be config-
ured individually by the user.

9.3.1. Creating a database backup (appliance tester)
Each time the ST 750, ST 750 A, ST 755 and ST 760 ap-

pliance testers are restarted, a database backup is created
automatically.

The database backups are located on the in-
serted SD card in the "Backups" file folder.
4/18/2017 10:23 AM

Backups File folder

Database backups are created with the _Backup name af-
fix and a numerical file extension. Example:
Test_Backup.001

The database Test Backup.001 corresponds to the first
automatically created database backup of the original da-
tabase Test.db.

In case of continuous database backup (after each restart
of the appliance tester), the numerical file extension in-
creases up to the maximum number of database backups.
Test_Backup.005

When the maximum number is reached, the principle of a
ring buffer is used.

The appliance tester overwrites the oldest database
backup with the latest database backup.

Marme - Date modified Type

| | Test Backup.001 08.03.2018 14:42 001-File
| | Test_Backup.D02 0O 002-File
| | Test Backup.003 0 003-File
| | Test_Backup.004 O 004-File
| | Test Backup.D05  08.03.2018 14:46 003-File

Continuously created database backups

MName Date modified Type

|| Test Backup.001  09.03.2018 14:47 001-File
| | Test_Backup.002 0O 14:43 002-File
| | Test_Backup.003 O 14:44 D03-File
| | Test_Backup.004 O 8 14:45 D04-File
| | Test_Backup.003  09.03.20 814:46 0053-File

Overwriting of the oldest database backup
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9.3.2. Creating a database backup (logging
software)

The BENNING PC-Win logging software allows the auto-
matic creation of database backups in a selected directory.
For this, Automatic backup must be enabled in the options
of the software.

Use the following menu path to navigate to the Automatic
backup option.

Customers

Test Samples
Complete result list
Statistic

Data Explorer

Ctrl+F

L

Search

| & [<]® LE wdo

Options

Automatic Backup

Create backup:

@ Yes
O Ne
5

L

Mo. of backups:

Backup Directory [ Select Directory

You can enable or disable the automatic database backup,
specify the maximum number of database backups to be
created and choose a backup directory.

The selected backup directory can be located on your local
PC or on an inserted removable medium (e.g. a USB
stick).

When the maximum number is reached, the principle of a
ring buffer is used.

The logging software overwrites the oldest database
backup with the latest database backup.

MName a Date moclified Type

| | Test_Backup.001  08.03.2018 14:42 001-File
| | Test Backup.DD2  08.03.2018 14:43 002-File
| | Test_Backup.003 08 0D3-File
| | Test_Backup.D04 05, 004-File
| | Test Backup.005  08.03.2018 14:46 003-File

Continuously created database backups

MName - Date modified Type

| | Test Backup.001  09.03.2018 14:47 001-File
| | Test_Backup.002  09.03.2018 14:43 002-File
|| Test Backup.0D3  09.03.2018 14:44 003-File
| | Test_Backup.004  09.03.2018 14:43 004-File
|| Test Backup.0D5  09.03.2018 14:45 005-File

Overwriting of the oldest database backup
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9.3.3. Restoring a database backup

You can use the BENNING PC-Win logging software to
restore a database. To do this, you need access to the
backup directory where the database backups are located.

To restore a database from the backup directory of the ap-
pliance tester, you must establish a connection to the SD
card.

To do this, follow one of the two options below:

1.

option
(Connect the appliance tester to the PC via a
USB cable.)

After having connected the appliance tester, the PC rec-
ognizes the appliance tester as a removable medium and
enables access to the inserted SD card.

Please make sure that the appliance tester is in operating

mode.
2. option

(Connect the SD card via an SD card reader.)

(An SD card reader is not included in the scope of deliv-
ery.)

After having connected the SD card reader, the PC recog-
nizes the inserted SD card as a removable medium.

To restore a database from the backup directory of the log-
ging software, you must establish a connection to this di-
rectory.
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Starting to restore a database:

Use the following menu path to navigate to the restore
function of the logging software:

If there are database backups in the selected directory, the
search results are displayed in the dialog box.

Please choose the backup you wish to restore

The following backups were found in your backup directary.
LA Please choose a backup file and press Ok to restore this backup.
L Press the folder button below to choose another backup folder.
-

C:WUsers\Documents

8% Search for backups

Repair Database

Compress Database

File |
|E| Database » |@. Create New Database
q;} Getting Started 5% Select Databaze
= Import Data 51  Save Database As
= @ Merge Database
B
=

Cloze Databaze

| Import Backup[} |

The following dialog box opens:

Please choose the backup you wish to restare

The following backups were found in your backup directory.
Please choose a backup file and press Ok to restore this backup.
Press the folder button below to choose another backup folder

CiUsersiDocuments

8% Search for backups

Available backups:

Filename Fileage Filesize No. of customers  No.of test objects Mo of results

Cancel

Click the Folder button and navigate to the storage loca-
tion where the database backups are located.

< [ 032018

e -
Home Share 1.

option: Local directory

5 (e. g. storage location of the logging soft-
Pinto Quick Copy Paste Ware)
u:gs_m n Opem e
> Database Backups > 082018 v O Search 08_2018 P
Meme = Date modified Type
b Quick access
| ] Test_Backup.001 8/20/2018 1:40 PM 001 File

OneDrive

[ This PC |

v = USB Drive ()
|'> Backups
¥ Network 2.

1item

option: SD card of the appliance
tester

(displaved as USB drive (E:))

>

You can use the backup directory on the SD card of the
appliance tester as well as the backup directory of the log-
ging software you have selected.

Confirm your selection by clicking “OK” and then click
“Search for backups”.
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Availsble backups:
Filename Fileage Filesize Mo. of customers Mo, of test objects Mo, of resutts
TestBackup_0DaysAgo sdf 2602201809:08.. 75776 4 5 0
Test_Backup.001 26.02201813:05... 108544 4 76 o
Test_Backup 002 26.02201813:08. 108544 4 76 0
Test_Backup 003 26.02201813:01 108544 4 76 0
Test_Backup.004 26.02201813:03.. 108544 4 76 o
Test_Backup.005 26.02201813:04.. 108544 4 76 o

Cancel

Select the required database backup and confirm your se-
lection by clicking “OK”.

A confirmation prompt for database overwriting opens.

Before confirming the overwrite procedure, note
what is displayed in your status bar!

The currently selected database is displayed in
the status bar.

Make sure that the currently selected database

corresponds to the database backup you want
to restore!

A

CA\ ..\ Documents\Neue Datenbank\Test Backup Wiederherstellung

The database backups belonging to Test.db contain the
name affix _Backup and a numerical file extension (e. g
*.001).

In this example, the database backup Test Backup.005
has been selected.

e

-, BENNING (GER)
-, BENNING (NL)
- BENNING {US)

After having restored the database successfully, the origi-
nal name of the original database is displayed in the data
explorer (Test.db).

Now, the database can be used as usual.
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9.4. Importing data

5 Import data

You can use the "Import data" function to add further
data from other databases to an existing database.

This function enables you, for example, to import data from
an Excel® file or from databases of the BEN-
NING PC-Win 700 logging software into a current
ST 750/ST 760 database.

Please observe the following steps when importing data
into a database to which you want to add data.

The manufacturer generally recommends mak-
ing backup copies before making changes to
existing databases. This prevents unintentional
loss of data in the event of an error.

A

Select the database to which you want to add data.
(See chapter 5.2, Select database.)

After successful selection, the selected database is dis-
played in the data explorer.

The two figures below show a test database to illustrate
the data import.

Data from other databases shall be added to the Test.db
database.

8-

|E| il
EI\,, , Test customer 1
E|i\ T_est department 1
Lo Tast sample 1

Use the following menu path to start the data import.

e |

El Database 3

()  Getting Started

|§} Import Data E

Exit

After successful execution, the "Import data" dialog box
opens.

1. option
(Data import from Excel®)

Please select where to import your data from

BENNING PC-Win 700
Imports data from BENNING PC-Win 700 software.

Microsoft Excel

Imports data from an Excel file. Please specify the table
structure in the next step.

Select the "Microsoft Excel® function. You will be asked
for the storage location of the Excel® file.

Alternatively, the BENNING company will pro-
vide you with a sample Excel® file for free
download.

You can fill the sample Excel® file with your
data and use it as a template.

The sample Excel® file contains additional filter
settings and all data import identifiers that are
intended for data import.

Use the following link to navigate to the down-
load of the sample Excel® file.

Import Data

Please select an Excel file containing the data. Specify the table structure in

the next step.
| Click here to download an exampel excelfile |<_
! =  SelectFile

Download link for sample Excel® file =

< Back Cancel

If an Excel® file already exists, click the Select file button
and navigate to the storage location of the Excel® file.

Select the Excel® file and confirm by clicking “Open”.
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The following aspects must be observed when importing

data from an Excel® file:

The Excel® table might contain more columns and infor-
mation than you need to import data.

The Excel® table must be available in *.xIs or

&

* xIsx format.

Unnecessary information can be selected and filtered via
the drop-down menus of the "Import data" dialog box.

Please observe the correct naming of the
worksheets. For data import, they must be

named continually in numerical (1...2...3) or de-

scending alphabetical ( Z+) order.

Example:
(1...2...3)

Worksheet 1 = 1. Data

Worksheet 2 = 2. Test procedures

OR
(2ly

Worksheet 1 = Data
Worksheet 2 = Test procedures

The Excel® table used in this example already contains
matching header names for each data import identifier.
However, you do not have to use every data import iden-
tifier.

Click the Next button to confirm the import of the database.

Import Data

The BENNING PC-Win logging software examines the

Excel® file according to a programmed pattern.

To do this, the system starts with the headers (line 1) on

the first worksheet of the table to be imported.

it
14

Header (line 1)

L[ -Iname

~ | Department

Welding device
2 Coffe machine |
3 Coffe machine Il
4 PRCD-S
5 PRCD-S
6 PRCD-S+
7 Water pump

dmg device

BN w e w

The BENNING PC-Win logging software recognizes the
header names of each column and makes them available
for data import in the following dialog box.

Dept. AT
Dept. Al
Dept. Al
Dept. Al
Dept. All
Dept. All
Dept. All
Dept. All

High-Tech
High-Tech
KOPP
KOPP
KOPP

ABB4693
4711
84712

87935

Water-Tech 6578912548A

Weld-Tech 58769KL

c o 5 s -
~ |Manufacut ~ | Serial numk | Customer ]
feld-Tec I Ge

69874WER

Worksheet 1.: (e. g. 1.Maintenance_:fésts)

BENNING (US)
BENNING (US)
BENNING (US)
BENNING (NL)
BENNING (NL)
BENNING (NL)
BENNING (NL)

1Ge
1Ge
8Ge
1Ge
23P
4Ge
25cl +

) > -
M e ) 7 ERSMIT = = ==
Please select the coresponding Excel column for the following data. If there &
y is no corresponding column, leave the field blank.
i i Customers not yet existing will be newly created. Click "Next" to import the
data.
D D s
i Name Name v
p| Serial no. v
»
Manufacturer v
Customer v
Department v
Test Test v
v,
<Back Next > Cancel
L1 Data import identifiers

Data import identifiers:

Header names from row 1 of the Excel® table

data
D

Name

Serial no.

Customer

Test

Manufacturer

Department

is no corresponding column., leave the field blank.
Customers not yet existing will be newly created. Click "Next" to import the

D

~

Customer
Department

Interval
Comment

Last Test
Manufacuturer
Next Test
Name

Serial no.

Test

<Back

4+—

Next > Cancel

ID Identification number of the test

sample
‘ Name Test sample designation

Serial no. Serial number of the test sample

Manufacturer Manufacturer of the test sample

Customer Customer for whom the tests are
carried out

Department Department in which the tests are
carried out

Test Selected test procedure

Interval Test interval

Next Test Date of next test

Comment Comments on the test sample

Last Test Date of last test

After the data import has been completed, confirm by click-
ing the Done button.

29
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The imported data are now displayed in the data explorer.

=)

---f , BENNING (GER)

|__—_|:" BENMING (ML)
(-4 Coffee maching |
G- Coffee machine |l
- Hlectric dril
3 PRCD K 10mA
[-<® PRCD-K 30mA
i Welding device
Jﬂ Test dept. |
[t k4| Test dept. Il

-, BENNING (US)

=

2. option
(Data import from the BENNING PC-Win 700 logging soft-
ware)

Import Data X

Please select where to import your data from.

BENNING PC-Win 700
Imports data from BENNING PC-Win 700 software.

Microsoft Excel
Imports data from an Excel file. Please specify the table

structure in the next step.

Select the “BENNING PC-Win 700"

Please select the file containing data of the BENNING 700. Click "Next" to
import data.

| Select Database 1

Current database:

[ <Back | e ~ Cancel

function.
You will be asked for the storage location of the database.

Click the Select database button and navigate to the stor-
age location of the database.

Select the corresponding database and note the selected
file format (*.mdb).

Benning 700 Database (".mdb™)

(*.mdb:*)

Benning 700 Database

Confirm by clicking “Open”.

Click “Next” to start the data import.

Import Data X

O e J y @0 ¢ ol 3 S
M . - [~ e F = .y =
‘ Please wait. Importing data...
N
’ ES
Importing customer 11/11
Importing test sample 86/211

Wait until the data import has been completed and then
confirm by clicking “Done”.

The imported data are now displayed in the data explorer.

F BENNING (GER)
-2, BENNING (NL)
(- Coffee machine |
;" Coffee machine 11
- Hectric dr
=% PRCD K 10mA
= PRCD-K 30mA
-3- Welding device
by Test dept. |
[t]-54/ Test dept. |l
- BENNING (US)

L=

=1

30
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9.5. Merging databases

The handling of your appliance tester(s) and the associ-
ated database(s) provides many possibilities that can be
important for database merging.

For database merging, the manufacturer recommends the
use of a master database (on a PC) and a work data-
base for each appliance tester.

Work database
Master database (on SD card for each appliance
(onaPC) tester)

9.5.1. Questions / general information

- May I subsequently change a customer name?

Each customer receives a unique name when cre-
ating a database.

If a customer is renamed in a database (master da-
tabase or work database), this customer must be re-
named identically in all other databases before

merging.
Otherwise, a new customer with all associated de-
partments, test samples and test results will auto-

matically be created in the master database when
the databases are merged later on.

- May I change a device ID?

Each device ID is unique for each customer and
may not be changed subsequently.

Using the device ID, the logging software identifies
the test samples (per customer).

If a device ID is changed, a new test sample will au-
tomatically be created in the master database when
the databases are merged later on.

(Ideally, a device ID is unique for all customers.)

31

Which database formats can be merged?

If the master database is a *.db database, *.sdf
and *.db databases can be added.

If the master database is an *.sdf database, only
*.sdf databases are allowed.

May | make the following changes to a test
sample in the work database?

Changing a test sample:

Yes, the test sample may be changed.
Other changes of different work databases might
be overwritten.

Changing the department name:

Yes, the department name may be changed.
Other changes of different work databases might
be overwritten.

Changing the test procedure:

Yes, test procedures may be changed.
Other changes of different work databases might
be overwritten.

Changing limits:
Yes, limits may be changed.

Other changes of different work databases might
be overwritten.

The following applies to all changes:

The time stamp of a change is the decisive cri-
terion for overwriting other database entries.
Older database entries are automatically over-
written by new database entries.

May | create and use new customer-specific
tests and customer-specific visual inspec-
tions in the work database?

No, the tests and visual inspections must be pre-
viously created in the master database.



BENNING PC-Win ST 750-760

BENNING

9.5.2. Using a database

The following use case describes how to use a database
when several test persons with different appliance testers
are working on the same test job.

The starting point is always a common master database.

This master database can be created before testing or
already exists (recommended file format: *.db).

Please observe the following test procedure:

Copy a master database to SD card:
e. g. BENNING.db

Dept. 1:
Development

| Master database |

Merge master database with work databases
(copies of the master database).

This use case enables both test persons to view all test
data in the master database during testing and inde-
pendently of each other.
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No customer names or device IDs must be
changed during the test procedure!

&=

Only change customer names or device IDs
(& after merging the databases with the BEN-
NING PC-Win logging software.

The described use case can be extended for any number
of test persons and appliance testers.

Moreover, the procedure described is suitable for individ-
ual test persons.

The individual steps of the procedure remain identical.
Only the number of test persons and appliance testers var-
ies.

All entries can be compared, evaluated and output in a
large variety of file formats in the finally merged master
database.

9.5.3. Steps to be taken in the software

=

You can use the Merge database function to merge
several databases.

Merge database

At the beginning, select a master database to which you
want to add all differing entries of the work databases.

In the following example, all data records from the work
database Test2.db shall be added to the master data-
base Testl.db.

Select the master database to which the customer entries
shall be added.

= (a1
Ele, . Test customer 1
B’J} 'I'_est department 1
i Tagt gample 1

Use one of the following menu paths to navigate to the
Merge database function:

1. option (menu bar)

File

|E| Database » | &L Create Mew Database

) Getting Started 5%  Select Database

5 Import Data 5. SaveDatabase As

Merge Database
Exit = El )

‘=%, Repair Database
;;_ Compress Database
= Close Database

Import Backup
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2. option (toolbar)

Create Mew Databaze
Select Database
Save Databasze Az

=
=

Merge Database |
(8

Close Database

The "Merge database” dialog box opens.
Click the Select databases button.

The "Open” dialog box opens.

87 Open

4 <« Documents > Database Search Database

v 0
=~ 0O @

Organize > Newfolder

Name
5 Quick access
[ Test.db

OneDrive [ Testz.db

[ This PC

== USB Drive (E] No preview available.

Backups

¥ Network

< >

File name: | Test2.db | |Alle Dateien (%)

Cancel

Select one or more work databases and confirm your se-
lection by clicking Open.

85 Merge data

| &—

Test2.db

Add databases

Merge Cancel

Click the Merge button.

After successful merging, all differing entries from the
work database Test2.db are stored in the previously se-
lected master database Testl.db.

=] | Testdb

EI-" Test customer 1

EIQ T_est department 1
‘=8 Teat sample 1
EIQ T_est department 2
=& Test sample 2

During merging, customer entries and device IDs from the
work database are compared with the customer entries

and device IDs of the master database. ldentical entries
are excluded from the import process.

9.6. Repairing a database

c

- Repair database

The Repair database function enables you to repair a
defective database.

Databases can be defective, for example, if an
interruption occurs during the read or write process on the
SD card.

@ Not all kinds of errors can be repaired.

33

In the following example, the database Test.db shall be re-
paired.

Use the following menu path to navigate to the Repair da-
tabase function:

Repair Database

Compress Database

Close Database

e
|EI Database ’|@- Create Mew Database
'Z;? Getting Started &% Select Database
5 Import Data 51 Save Database As
Bt 5 Merge Database
ik
i:';_
=

Import Backup

The "Select database” dialog box opens.

‘™| Plzase choose database

™ <« Documents » Database Search Database

New folder = - (7]

Type

~

Organize ~

Name
3+ Quick access
DB File

DB File

[ Test.db
[ Test2.db

OneDrive
= This PC
= USE Drive (E)
Backups

¥ Network
<

File name: | Test.db

ST755 Datei (*.db)

Open Cancel

Select the database to be repaired and confirm your selection
by clicking Open.

If the database is free of errors, the following message
appears:

BEMNMIMG PC-Win 5T 730-760

o The database is correct and must net be repaired.

Defective databases are opened and repaired by the log-
ging software.

After successful repair, the database appears in the data
explorer and is available for further use.
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9.7. Compressing a database

2. Compress database

This function allows you to reduce the size of a
database.

If data records of a database system are de-
leted, the storage location of the deleted data
record will not be released again.

These "empty storage locations" can occur
when using databases and inadvertently in-
crease the size of the database.

The Compress database function rearranges
existing data records and then removes the
"empty storage locations”.

The original order of the data records will not
be changed during rearrangement!

The manufacturer recommends using this fea-
ture regularly, particularly if large numbers of
data records have been removed from a data-
base.

The database size can only be reduced if the
BENNING PC-Win logging software can find
and delete "empty storage locations" in the da-
tabase.

&

In the following example, the database 1.db shall be
compressed.

Original size of the database:

| (%] 1.db 01.03.2018 09:54 Data Base File | 19.586 KBl

Select a database to be compressed.

%, Please choose database b
« - <« Documents » Database v O | Search Database bl
Organize New folder = M @
Name Date modified Type
s Quick access
[ 1.db 8/20/2018%17AM DB File
OneDrive
I This PC
= USB Drive (E)
Backups
¥ Network
< >
File name: | 1.db v‘ ST755 Datei (~.db) v

The selected database is shown in the data explorer.

= JE
=, BENNING (US)

. -4y Dept. Al

-, BEMMING (ML)

Use the following menu path to navigate to the Compress
database function.

‘['__l Database » | Ht  Create Mew Database
.;;3 Getting Started 5% Select Database

Import Data Save Database As

. Merge Database
Exit

=, Repair Database

.,.,_ Compress Database [

Close Database

Import Backup

Select the database to be compressed again and confirm
your selection by clicking Open.

%, Please choose database bd
« v 4| « Documents » Database v B | Search Database p
Organize v New folder =~ M @
Name Date modified Type
# Quick access
[ 1.d0 8/20/2018%17AM DB File
OneDrive
[ This PC
 USB Drive (E)
Backups
¥ Network
< >
File name: [ 1.db v (57755 Datei (o) v

After successful execution, the following dialog box opens:

BEMMIMNG PC-Win 5T 750-760 X

o Database successfully compressed

oK

In the Explorer of your Windows PC, you can trace a com-
pression that has been carried out.

To do this, compare the initial size of the database with its
current size after compression has been completed.

Database size after compression:

| [#] 1.db 01.03.2018 14:32 Data Base File | 18.189 KBl

In this example, the database size can be reduced from
19,586 KB to 18,189 KB.
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10.Options of the logging software

The options contain the basic settings of the
BENNING PC-Win logging software. You can view or edit
the existing print templates of the Report Designer.
The options are divided into:

- Default options

- Expert options

- Statistics report templates

Use the following menu path to navigate to the Options
function.

Wiew |

B Customers

= Test Samples

% Complete result list
W Statistic
Data Explorer

@M% Search Ctrl+F
Options [

The following dialog box opens:

Options *

Default  Expert  Statistic reports

Automatic Backup
Create backup: (@) Yes

O No

Mo. of backups: 5 =

Backup Directory  |[= Select Directory

Dataexplorer

() Show ID
(®) Show Name
(O Show ID and Name

Protocol

Print test date and time
Print remark

[ Automatically Search for Updates

Automatically Set Testdate when moving
devices
Auto compress

Company logo (271113 pixel recommended)

| f} Choose image xclearimage

Cancel

10.1.
10.1.1. Automatic backup

Default options

In the options, make the desired settings for automatic da-
tabase backup.

| Automatic Backup |

Create backup: ®) Yes
O No
Mo, of backups: B =

Backup Directory  |[— Select Directory

You can enable or disable the automatic database back-
ups, specify the number of database backups to be cre-
ated and select a backup directory.

The selected backup directory can be located on your local
PC or on an inserted removable medium (e.g. a USB
stick).

10.1.2. Data explorer

Changes the view in the data explorer according to the
selected option.

O D Fa
(®  Name F10 L\sJ
() IDand name F11

10.1.3. Report printout

Enable the following checkboxes to add the corresponding
information to the report printout.

Protocol
Print test date and time
Print remark

Automatically search for updates

The software automatically searches the Internet for
available updates of the BENNING PC-Win logging
software.

Automatically adapt next test date

This function updates the date of the next test when a
test sample is moved to another database or database
level in the data explorer.

Auto compress

If this checkbox is enabled, the Compress database
function is executed each time the program is started.

(See chapter 9.7.)
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10.1.4. Company logo

This function enables the integration of a company logo
into the print template “Test report” by default.

Company logo (271113 pixel recommended)

[ {y Choose image xClearimage

10.2. Expert options

Navigate to the Expert tab.

The following view appears.

Options *
Default  Expert  Statistic reports

Open more than one database at the same time

Printing

Customer list C:\ProgramData\Benning\DefCustomerList frc

Test sample list C:\ProgramData'Benning\DefTestobjectlist.fre

Test report list C:'\ProgramData\Benning\DefResultlist.frc

Test report  C:'\ProgramData\Benning\DefResult fric

Eesulitable C:\ProgramDatz\Benning\DefresultTable frc

The next reports are printed before fafter you print out the last test result for selected devices

Firstpsge C:\ProgramDats\Eenning\Deckblatt fre

First page  C:\ProgramData\Benning'Zusammenfassung.frc

Use right mouse button to choose option

Cancel

Open more than one database at the same time

=SR] Test db
i~ BENNING {GER)
- BENNING {NL)
- BENNING {US)
=4 1db
-~ BENNING (NL)
-~ BENNING (US)

If this checkbox is
enabled, several
databases can be open at
the same time in the data
explorer.

This allows you, for example, to copy database levels
from one database to another.

10.2.1. Printing

In the Printing pane, you will find the default print templates
of the Report Designer. You can use these print templates,
for example, to create lists or test reports of existing data-
base entries.

The manufacturer provides you with a large number of de-
tailed print templates, which can be easily adapted accord-
ing to your own needs by means of the Report Designer.

Printing |
v [
Customer | isl C:\ProgramDats\Benning\DefCustomerList fric

Print templates

Test sample lisf | C:\ProgramData'\Benning\DefT estobjectlist frc

Test report lis] | C:\ProgramData'Benning\DefResultlist frc

Test report| | C:\ProgramDats\Benning'\DefRes ult. frc

Resulitablg | C:\ProgramData'\Benning\Defres ultTable fric

Storage locations of the print
templates
First psge  C:\Progran -

The nest reponts 2re printed ba'rL

Eirst psge  C:\ProgramData'\Benning'Zusammenfassung frc

Usz right mouse button to choose option

To adapt a print template, move the mouse pointer over
the corresponding print template and right-click to open
the context menu.

o

Customer list C:Pr S -
LElomerls @ Choose file for printing
A “Edit file

@ Restore factory default

Clear report

You can
- select another print template,

- edit the current print template in the Report De-
signer,

- restore the default print template or
- delete the print template.

By default, the print templates of the manufacturer are se-
lected.

In the following, the different print templates are described
with  regard to their function and usability
(e. g. customer list, test sample list, etc.).
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Customer list Test sample list
The customer list corresponds to the print template for a  The test sample list corresponds to the print template for a
tabular customer overview of all existing customers. tabular test sample overview of all existing test samples.

| Customer [ Contactperson | Street adress [ Place ]

[[Kunden Kunden_Name] [[Kunden Kunden_An [[Kunden Kunden_Str ][Kunden Kunden_PLZ] |
Page [Page]/[TotalPages]

Test sample list

Report view (default template)

- - - - Test -
c Dy Dy
. sequence Next Test -]
i34

(Prufingeund®’™ [PrufiingeUnakunde * (PrufingeUndk * (PruflingeUndk ™ [PrifingeUnd " [PruflingeUn " [Prufiingsund |

Page [Page]/[T ges]
| Customer | Contact person | Street adress Place |

Print preview (default template) Report view (default template)

& Please observe the following steps to create or
print a print preview for a customer list.

Test sample list

i Desi Test

Select a database that contains customer entries. EenauS  maews o bwr BN wmwn
AM
Use the following menu path to navigate to the tabular PENNOLS e v e T S ™
“Customers” view.
Print preview (default template)
View
|rﬁ| Customers I | e Please observe the following steps to create or
2 Test Samples g print a print preview for a test sample list.
%1 Complete result list . .
- . Select a database that contains test sample entries.
@ Statistic
Data Explorer Use the following menu path to navigate to the tabular
“Test samples” view.
M Search Ctrl+F
Options e
B Customers
) ) o | = Test Samples I |
Click the Print preview icon. = — g
wal Complete result list
& 2LV @ @ Statistic
Customer Cortaiperson Street City H Data Explorer
BENNING (NL) M Search Ctrl+F
BEMNING (GER) 1 _
Options

The "Print preview” dialog box opens. Click the Print preview icon.

For the functions of the “Print preview" dialog box, refer to

the notes in chapter 10.2.2. EE Y @ fD
Customer m||:|
BENNING (US)
BENNING (US) 104
BENNING (US) 105
BENNING (US) 138

The "Print preview” dialog box opens.

For the functions of the “Print preview" dialog box, refer to
the notes in chapter 10.2.2.

37



BENNING PC-Win ST 750-760

BENNING

Results list

The results list corresponds to the print template of a tab-
ular test overview.

Unlike the results table, which lists all tests of the data-
base, the results list allows you to select individual tests
and print them together.

You can select the test samples or the subordinate tests
under "View -> Test samples" or "View -> Test results".

Test record for electrical devices
F[varPrufer] F[varKume]
[strPrier] [striKunde]
r[valrF‘rufgeran] r[warAuf&ralgswrnmer]
[strPrifgerat] [strufiragsnummer]
Results
View test Overall check
Date Designation D | Pc | ‘passes | RPE | mso | pE B o
TG — S EUETE LA T e =
[Seriendaten Priflingsbe i [Serienda [[Serienda |[Seriendaten.G
nPrrL:‘l]datu zeichnung] da:n\ T‘da:g Smhtggfung d:';g; ten ?‘50 ten.PE] | ten.B] esamtOk]
"Summary:[ParameterAnzahlOk] passed. [ParameterAnzahlFehler] failed.
Place, Date _Signature
PacelPagelTotalPaces! | [Ceryngrimeizind)

Report view (default template)

Prufprotokoll for elektrische Gerate

Admin BENNING Miederlassung (ML)

Priifer {in) Kunde

BEMMING ST 760

Prifgeraf Auftragsnummer

Ergebnisse

Datum Bezsichnung o | sk |SEMEfung | oee | opiso IPE ]
2812207 | RERETETRE R 0m |20 I — |oooma| ma —~ i
2512207 | RebETETRE R 0m |22 I — |oooma| ma — s
28122017 | Fereeme S 3 oea | o s — |omoma| ma - i
29.120017 | Fbpomme s 3w 2B Js — |oooma| ma — i
20122017 | FEemomme 3mSR | 1 Ia — |oooma| ma - I
27412017 | Kabsheringsrung | 380 | 1 Iz — |ooomn| ma — Is
2TA1.2017| Kabelveringsrung | 368 | 1 Iz — |ooomn| ma — Ia
27.11.2017 | Kabshveringsrung |~ ChC0 | 1 Iz — |ooomn| ma — Nein
2712017 Kabelverlingerung 3'6_35-'99 | Ja - 0,00 MO méA - Ja

Zusammenfassung:8 bestanden. 1 durchgefallen

O, Datum Unterschet

Print preview (default template)

Please observe the following steps to create or
print a print preview for a results list.

&

Select a database that contains test results.
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Use one of the following menu paths to create a results
list:

Anzicht

,'“, Kunden
|‘=._| Praflinge
% Tabellarische Ergebnisauflistung
@ Statistik
W

Datenexplorer

Suchen Strg+F

-

Opticnen

or

Ansicht

i

5 Kunden
= Ppriflinge
|% Tabellarische Ergebnisauflistung [
@  Statistik
« | Datenexplorer
M Suchen Strg+F
Optionen

Select test samples or tests.

A3s (V-8 2O

Customer - |D
BEMMING {U5)
BEMMING (LS)

BENMING (U5}
BEMMING (LIS)

Selecting test samples in the tabular “Test samples” view

v-a 82&

Customer 4 Designation Departement ]

BENMIMG (US) PRCD Dept. Al

CENNG U5

PRCD Dept. Al
PRCD Dept. Al

BENNING (US)
BENMNING (US)

Selecting tests in the tabular “Test results” view

You can select several entries by holding down the "CTRL"
key and clicking on individual entries
or select successive entries while holding down the
"SHIFT" key.
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Right-click one of the selected entries to open the context  Navigate to the test result of a selected test sample via one
menu. of the following menu paths.

Customer + D 1. To go to the test result of the selected test sample,

- e use the context menu as follows:
Print latest test record for selected test samples

"View -> Test samples" or

Print serial log for selected test samples I |

"View -> Test results"
PDF Export o N
[ Show results Y-1aE 28
Export Table » Customer 4 Designation Departement o]

Choose column

Print serial log for selected test samples

PDF Export »

In the context menu, click the "Print serial report for se-
lected test samples” option.

|m Show results I~

s o Export Tabl
The "Print preview” dialog box opens. port Tame g

Choose column

For the functions of the “Print preview" dialog box, refer to

the notes in chapter 10.2.2. or
« ” £ 38 (Y-8 IEE
Test result (“Test report”) ; ¢ -
g
The test result corresponds to the print template of an in- -
dividual test sample. A detailed test report will be created. Y- |8 E,J e
Ly

Test pckocct 1orahachial avices

2. To go to the test result of the selected test sample,
use the context menu in the data explorer as fol-
lows:

E--1d) Test_db_V61_20180129.db
" BENNING {GER)

Edit Customer

2 Weldi Delete Customer

4 Dept. All| - Export customer data to separate database
«» BENNING (U

MNew Test Sample

o

Edit Test Sample
Report view Print preview
(default template) (default template)

=]

Delete Test Sample

Show Result I

Dk

Print Result
Delete Result

= Please observe the following steps to create or Statistic
pl’ll’lt a pr'nt prEVIeW fOI’ a teSt I’eport Rename Building

Delete Building

Rename department

Select a database that contains test results.

Delete departement

Expand All
Collapse All

@

Search Element Cirl+F

Refresh F3

Copy
Paste

= Close database

The test result can also be opened by double-clicking a
test entry.
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The "Test of...” dialog box opens.

Test of 12/29/2017 1:15:11 PM x
B &
Please edit the missing test data

Test zample: Coffee machine |l
ID: [12.0005 |
Test date: [12/29/2017 1:15:11 P |
Next test [12/23/2m7 |
Test Procedure | PC |

Test

Reason for Testing (@) Periodic Inspection (O Modification

O Repair () Receiving Inspaction
Order no.: | |
Testinstrument. [BENNING ST 760 |
Softwareversion: [0.34/ GUI 0.10.21 |
Test person: |Adm|n |
Test company: | |
Place of test | |

Results
Visual inspection passed: No O Vigual tests
Electrical test passed:
Functicnal test passed: -
Overall test passed: No
O Measuring Results

Note

Cancel

Click the Print preview icon.

Test of 12/2%/2017 1:15%11 PM

Print Preview i I

The "Print preview” dialog box opens.

For the functions of the “Print preview" dialog box, refer to
the notes in chapter 10.2.2.
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Results table

The results table corresponds to the print template of a
tabular results overview.

Unlike the results list, which lists only test results of se-
lected test samples, you do not have to select anything in
the results table.

All test results will be printed.

Test results 2
Testame T Desigy
rgetnisse_Da_ [Ergebniss

Report view (default template)

Testresuits 2
Test date Test sequenca

43017

Designation
Lamp 1

Dapartmant Tost Ok Viewtest Ok eleciricaly Ok funcionally Ok

Dot Al pei e es es. s

8142017 Lamg 2 et Al kol ves ves ver ver

Print preview (default template)

Please observe the following steps to create or
print a print preview for a results table.

=

Select a database that contains test results.

Use the following menu path to navigate to the tabular
“Test results” view.

View |
5 Customers
= Test Samples
|§ Complete result list [ |
& Statistic
v | Data Explorer
M Search Ctrl+F
Options

Click the Print preview icon.

V- N E B R

1ag

Customer | print preview ftion

The "Print preview” dialog box opens.

For the functions of the “Print preview" dialog box, refer to
the notes in chapter 10.2.2.
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Cover sheet and summary

The two print templates Cover sheet and Summary are au-
tomatically attached to a test report printout as soon as
several test results are output simultaneously.

Print templates L )
ected devices

The r* reponts sre printed befors /after vo

C:\ProgramData'Benning\Deckblatt frc

Eirst page

Summary || C:\PregramData\Benning\Zusammenfassung frx

Use right mouse button 1-3%1-\-::- ortinn
Storage locations of the print
templates

The following steps show you how to create a test report
collection, including automatic generation of a cover sheet
with a final summary.

Use one of the following menu paths to create a test report
collection.

Please observe the particularities of the individual menu
paths.

View

,", Customers
|‘3 Test Samples " |
% Complete resultlil'ﬁf‘

& Statistic

Data Explorer

M Search Ctrl+F
Options

If you navigate via View -> Test samples, you can only
output the |atest test results for the selected test samples
later on.

Older test results will not be displayed!

or
Wiew
5 Customers
& Test Samples

|@ Complete result list [
& Statistic

Data Explorer

M Search Ctrl+F
Options

If you navigate via View -> Test results, you can choose
between all tests in the database.

You can also choose test results from older tests!
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Select test samples or tests.

222 V-0 2O

{n]

Customer -

BENNING (U5)
BENNIMNG (LI5)

BENMING (LIS}
BEMNNING (LU5)

Selecting test samples in the tabular “Test samples” view

or

V-1@a 2 2R

Customer & Designation Departemert D

BEMMING (L5) PRCD Dept. Al

sEnG 5

FRCD Dept. &1
Dept. Al

BENMING (U5)
BENMING (U5}

PRCD

Selecting tests in the tabular “Test results” view

You can select several entries by holding down the "CTRL"
key and clicking on individual entries
or select successive entries while holding down the
"SHIFT" key.

Right-click one of the selected entries to open the context
menu.

Print selected protocols
Print serial log for selected test samples

PDF Export

[~

Show results

[

Export Table

Choose column

In the context menu, click the "PDF export" option and se-
lect whether the data shall be output in a common PDF file
or in separate PDF files.

In both cases, both the cover sheet and the summary will
be created.

Export selected protocols in multiple PDF files (filename will be designation+ D+ Date time) l} |

If you have navigated via View -> Test samples, the option
"Export latest test report of selected test samples to one file"
appears.

Older test results will not be displayed!
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” Export selected protocels in one PDF file -

basi

If you have navigated via View -> Test results, the option
"Export selected reports to one PFD file" appears.

You can also choose test results from older tests!

The "Save as” dialog box opens.

Select the desired storage location and confirm the export
by clicking “Save”.

Please wait b4
Data is processed...

Cancel

Wait until the file conversion is completed.

In the following example, the option "...export to one PDF
file" has been selected.

After successful conversion, you can open the PDF file in
your directory.

The selected test reports have been summarized and pro-
vided with a cover sheet and a final summary.

Test from 8/22/2018 11:11:34 AM {“" =

Cover = Testreport1l

4 Summary
o —
- At 3
A semcarPepegu: 3

e i suocseas et ¢

==| Testreport2 Summary
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10.2.2. “Print preview” dialog box

B Save

Click the Save icon to save your tabular customer
overview in a variety of file formats.

When saving different file formats, take into ac-
e count the resulting file sizes as well as the re-
spective compatibility with other users of your

| '[9 || = | Data export - ] b
Home Share View (7]
= / . = >
= IJ %[ Movetor I Delete v E_h lﬂ E;] Eff seteata
= (= - kg Select none
k Copy Paste B - = New Properties
Py & [E Copyto =~ =fiRename e BE B nvert selection
Clipboard Organize New Open Select
&« “ A || « Database > Dats sxport v | & | Search Data export )
Name Date Type
3t Quick access .
DefresultTable.docx  £/22/2012 11:17 AM Microsoft Wol
OneDrive * DefresultTable.jpg /; IfanView JPG
0 This pC ] DefresultTable.pdf Adobe Acrobg
B DefresultTablexls Microsoft Exce
¥ Network < 5
ditems  1item selected 32.0KB =

E,*] Print

Click the Print icon to print your tabular customer
overview by means of an installed printer.

[ Openfile

Click the Open file icon to open a previously created
report (file format *.fpx).

(ﬂ Page setup

Click the Page setup icon to set the paper size,
orientation and margins.

Page Setup >
Paper
Ag ~

width:

Height: 21cm

Orientation:
() Partrait
{®) Landscape

Margins

Left: Right:
Top: Bottom:

Apply to all pages and rebuild report

oK Cancel

| e
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10.3. Statistics reports

The Statistics reports tab contains the print templates for
all statistics.

Here you will find the print templates of the

Database statistics,

Customer statistics,

Department statistics and

Error cause statistics.

Click Options and go to the Statistics reports tab.

The following view opens:

Options
Default  Ex

Statistics print templates

Statistic reports

Database statistic | | C:\ProgramData!Benning\DefDataBaseStatistic. frc

Customer statistic|

C\ProgramData'Benning\DefCustomerStatistic. frx

Jepartement statistic | | C\ProgramData\Benning\DefDepartementStatistic. fric

Detail statistic | | C:\ProgramData'Benning\DefDetail Statistic. frx

Use right mouse button to choose :4 ion

Storage locations of the statistics print
templates

Cancel

To adapt a print template, move the mouse pointer over
the corresponding print template and right-click to open
the context menu.

Database statistic C:\Pr S —efre
]@ Choose file for printing
Edit file
|Iﬂ h fre
@ Restore factory default
Clear report
£ar repor i i

You can

select another print template,

edit the current print template in the Report De-
signer,

restore the default print template or

delete the print template.

By default, the pre-installed statistics print templates of the
manufacturer are selected.

In the following, the statistics print templates are described
with regard to their function and usability (e. g. database
statistics). Other statistics print templates are used in the
same way.
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Statistics print templates

A statistics print template defines the print output of the
selected statistics.

The manufacturer provides you with a large number of de-
tailed print templates, which can be easily adapted accord-
ing to your own needs.

Statstik gor Datenban “[Datenbank]”

Report view Print preview
(default template, e. g. “Database  (default template, e. g. “Data-
statistics”) base statistics”)

Please observe the steps described in chapter 8.2 to cre-
ate or print a print preview for the statistics.

To edit statistics, e. g. customer, department or
error statistics, the database used must con-
tain corresponding entries.
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11.Report Designer

The Report Designer is intended for the convenient crea-
tion of technical reports and uses the print templates of the
BENNING PC-Win logging software.

(See chapter 10.2.1 for information on print templates.)

The print templates include all contents required to docu-
ment the normative specifications.

11.1. Application

By means of the provided print templates, you can consist-
ently log all test procedures of the appliance tester and
make them available in digital form or as a printout.

The following chapters describe the most common appli-
cations of the Report Designer software.

For further information on how to use the Report Designer,
use the following menu path to navigate to the correspond-
ing manufacturer’s documentation (“FastReport Help”).

Help

Register your product
Check for Updates

Help
Benning 5T 735/ 5T 760 Help

BEMMING PC-Win 5T 730-760 Help
FastReport Help

I,
Information about other tel'ﬁ'Fdevices

About

The Report Designer included in the BENNING PC-Win
logging software is not subject to the technical support of
the BENNING company.

11.1.1. Inserting a company logo

You can open an existing print template and add your own
graphics.

In the following example, a company logo is inserted in the
Customer list print template.
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Navigate using the following menu path:

B Custorners

= Test Samples

= Complete result list

& Statistic

Data Explorer

M Search Ctrl+F

Options [

Options X
DefaultStatistic reports

Open more than cne database at the same time

Customer list C:\ProgramDatz\PenninaNefCustomerl ist fre !

Choose file for printing

Edit file N |
@ Restore factory default

Prirting

Test sample list C:\Progra mDI:

Clear report

Test report list C:\ProgramData'Benning DefRes UNLIst M

The Report Designer with the corresponding print template
opens.

BENNING

T ——

Select the Image button on the left edge of the
screen and drag the positioning frame of the
graphic to the desired position in the print tem-
plate.

Left-click to confirm the final position.

10,75 cm; 0 cm

StraBe | Ort
| [Kunden Kunden_Str - |[Kunden Kunden_PLZ]
1ges]
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You can edit the positioning frame by double-clicking the
left mouse button or using the context menu with the right
mouse button.

The following dialog box opens:

Edit Picture *
Picture |_’|’ Load E‘_'IPastE <2 Clear [o] Edit
Data column
File name
Hyperlink
*

Click the Load icon to load an image file from a storage
directory.

Click the Paste icon to insert an image file from your cur-
rent cache.

Click the Load button and select the corresponding image
file in your storage directory.

Confirm your selection by clicking “OK”.

The image preview shows your current image selection.

Edit Picture x
Picture \_T Load E‘_'IPaste 2 Clear |& Edit
Data column
File name
Hyperlink
274 = 45
ox

Confirm your selection by clicking “OK”.

r l

The image you selected is now dis-
played in the print template.

The size of the graphic is adapted to
the positioning frame.

BENNINE
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o o ]

Drag the selected positioning frame
ESENNIN to the de.swed size. .

To do this, use the resize handles of
" . . the positioning frame.

The selected graphic proportionally adapts to the size of
the positioning frame.

BENNING

| Contact peron [ Street adress Place
|[Kunden Kunden_An ‘[Kunden Kunden_Str ‘[Kunden Kunden_PLZ] ‘

Page [Page]/[TotalPages]

[ Customer
[[Kunden-Kunden_Name]

, Click the Save icon in the menu bar of the Re-
port Designer.

Since you are about to modify a protected print template,
an error message appears.

Confirm this error message by clicking OK and select a
new storage location for the modified print template.

Go back to the BENNING PC-Win logging software.

Change the storage location of the default print template
to the storage location of your customized print template.

Navigate using the following menu path:

Options
Defautt  Expert  Statistic reports

Open more than one database at the same time

Printing

Customner list C-\Usersiangenendt\Desktop\Ubersetzung der Report-

ru |@ Choosefi Iﬁfor printing L Logo.frc
L
Edit file
Test sample list L/ er Report-
Drul @) Restore factory default frc
Clear report
Test report list C:\Lserswmgenemnmm owerserumgder Report-

Druckvorlagen'DefResu It.fr::

Select the modified print template and confirm by clicking
Open.

Close the Options dialog by clicking OK.

When creating a print preview, you will now see the com-
pany logo you have inserted.

BENNING

[ Customer [ Contact person | Street adress | Place ]
| BENNING (US) | | | |
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11.1.2. Inserting a barcode / QR code

You can open an existing print template and add a code
positioning frame.

It is absolutely important to differentiate whether the print
template contains an individual test sample
or a list of test samples.

This is of particular importance when assigning properties
to the code positioning frame.

1. option

(The code positioning frame to be inserted re-
fers to an individual test sample.)
Example: Print template Test report

In the print template Test report, a detailed test report is
generated for an individual test sample.

For this reason, you can use the device ID of the individual
test sample when assigning properties to the code posi-
tioning frame.

Navigate using the following menu path:

B Custorners
= Test Samples
% Complete result list
@ Statistic
Data Explorer
@M% Search Ctrl+F
Options [,
Options *

Default Statistic reports

Open more than one database at the same time

Prirting

Customer list C:\ProgramData\Benning\DefCustomerList.frc
Test sample list C:\ProgramData\Benning\DefTestobjectlist.frc

Test report list C:'\ProgramData\Benning'DefResultlist frc

I 1 Riaht-click
e — rt-

= C%osefilefor printing )
LA Editfile I
[~] Restorefakgjr)r default

Clear report

Testreport C
D

der Report-

Besulttsble C
D

Tha naxt reports 2re printed bafors /after you print out the lzst test result for selected devices
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The Report Designer with the corresponding print template
opens.

& Confiuetuns.

\ et Tt

Pzt e

I
T

In this example, a Codel128 is used.

Click the Barcode icon on the left edge of the
screen and select the required code.

When selecting a code, make sure that your barcode scanner
supports the selected barcode.

L3

2{5 Interleaved
25 Industrial
215 Matrix
Codabar
Code128

[

Code39

= =tenderd

Drag the code positioning frame to the desired position in
the print template.

Left-click to confirm the final position.

rF!emark: |
[Bemerkungen]
1414 cm; 0]
12345678
g
Drag the selected positioning frame
to the desired size.
To do this, use the resize handles of
12345676 the positioning frame.

=y
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.
Remark:

o NHH “ ‘ m H‘ “‘ W
12345678

You can edit the code positioning frame by double-clicking
the left mouse button or using the context menu with the
right mouse button.

The following dialog box opens:

Barcode Editor

i Data Sources
System Variables
Jfe Functions

12345678 -
4
-

Save

Cancel

Delete the default sequence of numbers (12345678) in the
input field of the editor and assign the Device ID property
to the code position frame.

To do this, open the following level in the tree structure of
the dialog box.

Data Sources
-] Ergebnisse
-] Questions
-] Adminanswers
-] Customeranswers
-] ViewGuestions
-] FragenfAntworten
-] Geraste
T Geraete_Index

Bc-c- D

12| Geraste_Kunde

Press and hold the left mouse button, drag the Device ID
property into the input field of the editor and release the
mouse button.

Barcode Editor

[Geraete Geraete_|D]|

Confirm your entries by clicking “OK”.
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Click the Save icon in the menu bar of the Re-
port Designer.

Since you are about to modify a protected print template,
an error message appears.

Confirm this error message by clicking OK and select a
new storage location for the modified print template.

Go back to the BENNING PC-Win logging software.

Change the storage location of the default print template
to the storage location of your customized print template.

Navigate using the following menu path:

Options
Defautt  Expert  Statistic reports

Open more than one database at the same time

Prirting

Customer list C:\ProgramData\Benning\DefCustomerList.frc

Test sample list C:\ProgramData'\Benning\DefTestobjectlist.frc

Test report list C:\ProgramData'Benning'DefResultlist frc

Test report g |@ Choose file for printing der Report
J Editfile 1S

Besulttable 83 @ Restore factory default der Report-
Clear report

Tha naxt reports 2re printed bafors /after you print out the lzst test result for selected devices

Select the modified print template and confirm by clicking
Open.

Close the Options dialog by clicking OK.

When creating a print preview, you will now see the bar-
code you have inserted.

dent no.:

1234
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2. option
(The code positioning frame to be inserted re-
fers to several test samples.)

Example: Print template Results list

The steps to be taken for creating, positioning and saving
are identical to those for using an individual test sample.

Only the property assignment of the code positioning
frame has to be adjusted.

Open the Results list print template and create a code po-
sitioning frame as described in option 1.

In this example, the columns RPE, RInsu, IPE and ICont
of the default print template are removed and replaced by
a corresponding barcode column.

[ A

=
Test record for electrical devices

L a
- B A - -~
[warPriifer] [varkunde]
[stPrifeq [sirunde]
. J . n
r[vﬂrF'rUfgerit] -: r[vﬂrAuﬂragsnummar] -:

[strAufragsnummen]
4 - 4

[strifgers]
-

- -~
Results
C 4
a 5 View test Overall check
| Date | Designstion | D | PC ‘ passes RPE | RISO | IPE | :3 passed |
e e sten Priflingabe | o | [ [ L [ e e e ol  [Serenazien G
r.P['I;‘fT.nH. zsichnung] = .ain_lr.\ ::"-:‘.:5 SKH‘_En.fLr, ;Lgl. I_r.IiIISD ten.IPE] | ten.lB] esamtOK]
:SurnmaryI [ParameterAnzahlOk] passed. [ParameterdnzahlFehler] failed. :
Place, Date Signature
! s a
\Page IPsoel/TotalPsoes] . ey
Results list with RPE, RInsu, IPE and ICont
®
Test record for electrical devices
r[varPr‘L'lfer] r[varKunde]
[strPrifer] [strkunde]
r[varF'rufgerét] r[varAuftragsnummer]
[strPrufgerat] [strAuttragsnummer]
Results
View test Overall check
Date Designation D PC e Barcode e
T Prifingsbe | ¢ T Seriendaten. G
P | S aatent | ncate | Siciproiung III\IIHI\HI\I\[!JJ\M!\[\M[I}%HIII\HI\I\ \IIIII!! 7%

"Summary:[ParameterAnzahlOk] passed. [ParameterAnzahiFehler] failed.

Place, Date Signature

"Page [Pagel/[TotalPages] [Copyighimeidng] |

Results list with barcode column
You can edit the code positioning frame by double-clicking

the left mouse button or using the context menu with the
right mouse button.

The following dialog box opens:

Barcode Editor x

12345678 [#-[4) Datenquellen
I3 Parameter

[+ Systemvariablen
[+ fi Funktionen

Abbrechen

Delete the default sequence of numbers (12345678) in the
input field of the editor and assign the ID property to the
code positioning frame.

To do this, open the following level in the tree structure of
the dialog box.

[=~| 2 Data Sources
. @~ Geraete
-7 Ergebnisse
=[] Seriendaten
C A Priflingsbezeic

----- A| Prifdatum

Press and hold the left mouse button, drag the ID property
into the input field of the editor and release the mouse but-
ton.

Barcode Editor

[Serendaten.|0]

Confirm your entries by clicking “OK”.

Finish editing as described in option 1.

When creating a print preview, you will now see the bar-
codes you have inserted in the print template.

D
»
20.1 ID
numerical
125
g values
: 126
Barcode
20.1
L » ||||||1|g|5||||||||
IO
126

Generated barcodes
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12.Service contacts

Spare parts management
Phone: +49 2871 93-553
E-mail: spareparts@benning.de

General service requests
Phone: +49 2871 93-556
E-mail: servicerequests@benning.de

Returns management
Phone: +49 2871 93-554
E-mail: returns@benning.de

Training management
Phone: +49 2871 93-557
E-mail: trainingscenter@benning.de

Technical support

Phone: +49 2871 93-555
E-mail: helpdesk@benning.de
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Support / helpdesk
BENNING helpdesk team
Phone: +49 2871 93-555
Fax: +49 2871 93-6555

E-mail: helpdesk@benning.de
Website: www.benning.de

Text and illustrations correspond to the technical status at the time of printing. Subject to technical changes. No liability for printing errors.
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